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Brief Supplement Overview 
This supplement to the Inland Empire Health Plan Outpatient and Emergency Department 
Antimicrobial Stewardship Toolkit provides additional resources including: 

1) A template for a brief stewardship plan 
2) A template stewardship commitment statement for use within the organization 
3) Stewardship education resources for patients and providers 

For questions, concerns, or feedback about the toolkit, please email the Inland Empire 
Health Plan Regional Quality Team at DGRegionalQuality@iehp.org and/or the California 
Department of Public Health Antimicrobial Stewardship Team at HAI_AS@cdph.ca.gov. 
We welcome your suggestions. The California Department of Public Health Antimicrobial 
Stewardship Team also offers one-on-one stewardship consultations upon request.* 

*Antimicrobial Stewardship (includes consultation link) | CDPH 
(www.cdph.ca.gov/Programs/CHCQ/HAI/Pages/AntimicrobialStewardshipLandingPage.a 
spx   
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Brief Stewardship Plan Template 
Stewardship Team 
Stewardship champion (name and title): 

Facility leadership stewardship contact (name and title): 

Other team members (e.g., physicians, pharmacists, nurses, managers, directors, 
information technologists): 

Stewardship Goals 
The most effective goals are specific, measurable, achievable, and time-bound. Example: 
We aim to reduce inappropriate prescribing for bronchitis and bronchiolitis, as evidenced by 
the Healthcare Effectiveness Data and Information Set (HEDIS) metric for avoiding antibiotic 
treatment for acute bronchitis/bronchiolitis (AAB), by 25% over the next 12 months. 

1)  

2) 

Meetings and Communication 
1) The stewardship team will meet to 

evaluate antibiotic use data, discuss stewardship program barriers and feedback, and 
adapt our stewardship plan. 

2) The stewardship team will update facility leadership on our stewardship plan and 
progress  . 

3) The stewardship team initially communicated goals and interventions with staff on 
. 

We will update staff
to ensure consistent communication and patient-expectation setting. 

Commitment 
We will do the following to adhere to the commitment core element (consider at least one 
method of commitment from the Stewardship Toolkit document, for example, displaying 
provider stewardship commitment posters in the waiting room): 

1) 

2) 
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Action 
We will do the following to adhere to the action core element (consider at least one action 
from the Stewardship Toolkit document, for example, publicizing guidelines for common 
conditions or encouraging the Dialogue Around Respiratory Illness Treatment (DART) 
communication framework): 

1) 

2) 

Tracking and Reporting 
We will do the following to adhere to the tracking and reporting core element (in addition to 
tracking HEDIS AAB, consider if additional methods of tracking and reporting from the 
Stewardship Toolkit document would be practical, for example, tracking the proportion of 
visits leading to an antibiotic prescription): 

1) We will track HEDIS AAB quarterly, including reviewing overall trends and comparing 
our performance with IEHP and NCQA benchmarks. 

2) We will report stewardship progress to staff and leadership at least annually. 

3)  

4) 

Education 
We will do the following to adhere to the education core element (consider at least one 
method of education from the Stewardship Toolkit document, for example, displaying 
waiting room posters to educate patients on appropriate antimicrobial use): 

1) 

2) 

Other notes 
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Internal Stewardship Commitment Statement 
Template 
The CDC estimates that half of outpatient antimicrobials prescribed in the United States 
may be inappropriate, and that at least 30% of outpatient antimicrobial prescriptions are 
unnecessary. Additionally, up to 70% of patients diagnosed with acute bronchitis are 
inappropriately prescribed antibiotics.† 

is committed to optimizing antimicrobial use through 
antimicrobial stewardship. In addition to limiting the threat of spreading antimicrobial 
resistance, these efforts will benefit our patients by reducing their risk of Clostridioides 
difficile colitis, adverse drug reactions, and resistant infections. A summary of our 
stewardship plan is available at . 

Please reach out to with any questions, ideas, and feedback. 

Signature of Stewardship Leader: 

Signature of Facility Leader: 

† Core Elements of Outpatient Antibiotic Stewardship | Antibiotic Prescribing and Use | 
CDC  (www.cdc.gov/antibiotic-use/hcp/core-elements/outpatient-antibiotic-
stewardship.html)  

March, 2025 • © 2025, V2.0 7 

https://www.cdc.gov/antibiotic-use/hcp/core-elements/outpatient-antibiotic-stewardship.html
https://www.cdc.gov/antibiotic-use/hcp/core-elements/outpatient-antibiotic-stewardship.html


 

                                                                                         

  
  

  
  

  
       

       

   
   

    
  

   

    

  
  

 

 

 

 

     

  

 
   

 

 

  

Healthcare Effectiveness Data and Information Set 
(HEDIS) Metric: Avoiding Antibiotics for Acute 
Bronchitis/Bronchiolitis (AAB) 
HEDIS (Healthcare Effectiveness Data and Information Set) metrics were created by the 
National Committee for Quality Assurance (NCQA) to evaluate and compare the quality of 
care across different health plans. HEDIS metrics are also used by many health plans, 
including the Inland Empire Health Plan (IEHP), to internally monitor care quality. 

Of the more than 90 HEDIS metrics, four relate to antimicrobial stewardship. IEHP has 
chosen to emphasize the avoidance of antibiotic treatment for acute 
bronchitis/bronchiolitis (AAB) metric. AAB is calculated as the percentage of “episodes for 
members three months of age and older with a diagnosis of acute bronchitis/bronchiolitis 
that did not result in an antibiotic dispensing event”.1 The target AAB is 100%, as 
antibiotics should not be prescribed solely for acute bronchitis/bronchiolitis. Patients with 
a secondary diagnosis requiring antibiotics are excluded from the calculation. 

For additional information on AAB and other stewardship-related HEDIS metrics, please 
see the references below.1—4 

1. HEDIS® High Performers in Antibiotic Stewardship Methodology (PDF) | NCQA 
(antibiotics.ncqa.org/static/media/HighPerformersMethodology.75fc0930d6c77f1f8f0 
f.pdf)  

2. HEDIS Quality Measure Toolkit | Johns Hopkins Health Plans 
(www.hopkinsmedicine.org/johns-hopkins-health-plans/providers-physicians/health-
care-performance-measures/hedis)  

3. Measurement and Evaluation Approaches to Improve Outpatient Antibiotic Prescribing 
in Health Systems (PDF) | CDC (www.cdc.gov/antibiotic-use/pdfs/measurement-
evaluation-improve-outpatient-508.pdf)  

4. Arena et al.  Navigating performance measures for ambulatory antimicrobial  
stewardship: a review of HEDIS® and other metrics the steward should know. 2024 | 
ASHE (pmc.ncbi.nlm.nih.gov/articles/PMC11696599/)  
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Resource  Collections  and Toolkits  
CDC Publications on Demand | CDC (wwwn.cdc.gov/pubs/) 
Searchable  collection of downloadable  CDC resources.  Resources available in multiple  
languages.  

Antibiotic Stewardship Resource Bundles | Antibiotic Prescribing and Use | CDC 
(www.cdc.gov/antibiotic-use/hcp/educational-resources/stewardship/index.html)  
CDC bundle of stewardship resources. 

Antibiotic Prescribing and Use | Antibiotic Prescribing and Use | CDC  
(www.cdc.gov/antibiotic-use/) 
Additional CDC stewardship resources and educational materials. 

Patient Education Resources | Antibiotic Prescribing and Use | CDC  
(www.cdc.gov/antibiotic-use/communication-resources/index.html)   
Large collection of CDC education resources targeted for patients.  Includes handouts, 
brochures, posters, web images, graphics, and videos. 

Educational Materials for Healthcare Providers | Antibiotic Prescribing and Use | CDC  
(www.cdc.gov/antibiotic-use/hcp/educational-resources/index.html) 
Large collection of  CDC s tewardship e ducation  resources t argeted  for  providers.  Includes  
patient handouts,  symptom  prescription pads, posters,  and videos.  

Improving Outpatient Antibiotic Prescribing: Toolkit for Healthcare Payers (PDF) | CDC 
(www.cdc.gov/antibiotic-use/core-elements/pdfs/AU-Outpatient-Payer-Toolkit-508.pdf)  
CDC toolkit to guide health plans in implementing antimicrobial stewardship.  Includes 
commitment letters, peer comparison letters, and project examples. 

Toolkit To Improve Antibiotic Use in Ambulatory Care | Agency for Healthcare Research 
and Quality  
(www.ahrq.gov/antibiotic-use/ambulatory-care/index.html) 
Agency for Healthcare  Research and Quality ( AHRQ)  toolkit on  implementing  antimicrobial 
stewardship in ambulatory settings.   Includes a  large collection of educational materials  
and presentations.  

How to Guide: Starting an Outpatient ASP – Pediatric Infectious Diseases Society 
(pids.org/pediatric-asp-toolkit/outpatient-settings/how-to-guide-starting-an-
outpatient-asp/)  
Pediatric Infectious Diseases Society (PIDS) stewardship toolkit with educational 
materials. 
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Urgent Care Antibiotic Stewardship Toolkit | College of Urgent Care Medicine (PDF) 
(urgentcareassociation.org/wp-content/uploads/2023/04/Antibiotic-Stewardship-
Toolkit-updated-20230417.pdf)                
College of Urgent Care Medicine stewardship toolkit including internal commitment 
letters. 

MITIGATE antimicrobial stewardship toolkit: a guide for practical implementation in adult  
and pediatric emergency department and urgent care settings | CDC                  
(stacks.cdc.gov/view/cdc/80653)     
Frequently referenced comprehensive toolkit on initiating stewardship in emergency 
department and urgent care settings. 

Minnesota  Antimicrobial Stewardship Program Toolkit for Outpatient Clinics  - MN Dept. of  
Health  
(www.health.state.mn.us/diseases/antibioticresistance/hcp/asp/out/index.html)  
Minnesota Department of Public Health stewardship toolkit with resources including 
commitment posters and waiting room materials. 

TAPOUT Playbook (PDF) | LA County 
(publichealth.lacounty.gov/acd/docs/TAPOUT_Playbook.pdf)  
Los Angeles County toolkit with resources and education on outpatient antimicrobial 
stewardship. 

Antibiotic Stewardship | Urgent Care Association 
(urgentcareassociation.org/about/antibiotic-stewardship/)  
Resources and education from the Urgent Care Association including a toolkit 
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Sampling of Available Resources and Educational 
Materials 
CDC Provider Commitment Office Poster (PDF) 
(www.cdc.gov/antibiotic-use/media/pdfs/Commitment-Poster-P.pdf) 

March, 2025 • © 2025, V2.0 11 

https://www.cdc.gov/antibiotic-use/media/pdfs/Commitment-Poster-P.pdf


 

                                                                                         

 

 

CDC Provider Commitment  Office P oster-Spanish (PDF)  
(www.cdc.gov/antibiotic-use/media/pdfs/es/CommitmentLetter-11by17-ES-P.pdf) 
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AHRQ Provider Commitment Office Poster (English and Spanish) 
(www.ahrq.gov/antibiotic-use/ambulatory-care/strategies/index.html) 
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AHRQ Commitment Poster Directions (Copied from AHRQ) 
How to “sign” the document 

Once the document is opened in Microsoft Word, click on the “Signatures” text (located on 
the bottom right side of the page). This word is in a text box. 

Use this text box to insert the photographs and signatures of the individuals you believe 
are important to indicate your institution’s commitment to prescribing antibiotics 
responsibly. If the poster is being displayed in a general area of the clinic, consider having 
executive leadership and other influential leaders (e.g., medical, pharmacy, and nursing 
administrators) “sign” it. If it is being displayed in a specific clinic, consider having the 
physicians, nurses, and other staff sign it. 

How to add a logo 

If you choose to add a logo to this document, there are two placement options—in the 
signature text box or on the footer (next to the AHRQ logo). 

Add logo to signature box 

1. Click on the “Signatures” text (located on the bottom right side of the page). This
word is in a text box. Make sure your cursor is where you want the logo to be
inserted in the box.

2. Go to the “Insert” tab.
3. Click on “Pictures” from the Insert tab.
4. A window will pop up so you can search your computer for the logo. Select your

logo (.jpg or .png format) and click the insert button.
5. Your logo will appear in the textbox.

Add logo to footer (next to AHRQ logo) 

1. Open the footer section (either double click in the footer section of the document
or go to the “Insert” tab-> select the drop-down menu for “Footer”-> and click on
“Edit Footer”).

2. Follow the same steps 2–4 from “Add logo to signature box.”
3. Your logo will appear in your footer and will be moved around just as you move

around text (in line). If you want to move the logo image around freely, click on the
logo-> go to the “Format” tab -> click on the “Wrap Text” drop-down menu -> and
select “In front of text.”

4. When you are satisfied with the placement of the logo, exit the footer section
(either double click outside of the footer area or go to the “Design” tab-> and click
the “Close header and footer” button).
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CDC Delayed Antibiotic Prescribing Prescription Pad (PDF) 
(www.cdc.gov/antibiotic-use/media/pdfs/RCx-Delayed-Prescribing-sm-v9-508.pdf) 
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CDC  Delayed Antibiotic  Prescribing  Prescription Pad-Spanish 
(PDF)  
(www.cdc.gov/antibiotic-use/media/pdfs/es/RX-Pad-DelayedPrescribing-S-ES-P.pdf)  
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CDC Symptom Relief for Viral Illnesses Prescription Pad (PDF) 
(www.cdc.gov/antibiotic-use/media/pdfs/RCx-Relief-Viral-Illness-lg-v8-508.pdf) 
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CDC  Symptom Relief  for  Viral  Illnesses Prescription Pad-Spanish 
(PDF)  
(www.cdc.gov/antibiotic-use/media/pdfs/es/RX-Pad-ReliefViral-L-ES-P.pdf)  
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CDC Symptom Relief for Cold and Cough Prescription Pad (PDF) 
(www.cdc.gov/antibiotic-use/media/pdfs/HCP-Relief-Colds-Cough-85by11-P.pdf) 
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CDC  Symptom Relief  for Cold and  Cough Prescription Pad-Spanish 
(PDF)  
(www.cdc.gov/antibiotic-use/media/pdfs/es/HCP-Relief-For-Colds-85by11-ES-P.pdf)  
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CDC Watchful Waiting Prescription Pad (PDF) 
(www.cdc.gov/antibiotic-use/media/pdfs/Watchful-Waiting-Prescription-Pads_large-
P.pdf) 
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    CDC Watchful Waiting Prescription Pad-Spanish (PDF) 
(www.cdc.gov/antibiotic-use/media/pdfs/es/Rx-Pad-Watchful-Waiting-large-ES-
508.pdf)  
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   Antibiotics and Adverse Events Provider Education (PDF) 
(www.cdc.gov/antibiotic-use/media/pdfs/AntibioticSafety-HCP-P.pdf) 
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   CDC: Do Antibiotics Have Side Effects? (PDF) 
(www.cdc.gov/antibiotic-use/media/pdfs/Do-Antibiotics-Have-Side-Effects-508.pdf) 
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    CDC: Taking Your Antibiotics (PDF) 
(www.cdc.gov/antibiotic-use/media/pdfs/Taking-Your-Antibiotics-RxPad-Lg-P.pdf)  
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CDC:  Taking  Your  Antibiotics-Spanish (PDF)  
(www.cdc.gov/antibiotic-use/media/pdfs/es/Taking-your-Abx-Rx-Pad-85by11-ES-P.pdf) 
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CDC Viruses or Bacteria Patient Handout (PDF) 
(www.cdc.gov/antibiotic-use/media/pdfs/VirusOrBacteria-Original-P.pdf) 
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CDC Viruses or Bacteria Patient Handout-Spanish (PDF) 
(www.cdc.gov/antibiotic-use/media/pdfs/es/Virus-Bacteria-Chart-ES-508.pdf) 
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CDC Antibiotics Aren’t  Always the A nswer  Trifold  for  Patients 
(PDF)  Page  1  
(www.cdc.gov/antibiotic-use/pdfs/AntibioticsArentAlwaystheAnswer-H.pdf)  
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CDC Antibiotics Aren’t  Always the A nswer  Trifold  for  Patients 
(PDF)  Page  2   
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CDC  Preventing  and Treating  Bronchitis Patient  Handout  (PDF)  
Page  1  
(www.cdc.gov/antibiotic-use/media/pdfs/Preventing-and-Treating-Bronchitis-508.pdf)  
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CDC  Preventing  and Treating  Bronchitis Patient  Handout  (PDF)  
Page  2  
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CDC Use the Right Tool Office Poster (PDF) 
(www.cdc.gov/antibiotic-use/media/pdfs/print-psa-right-tool-11by17-508.pdf) 
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CDC Do You Need Antibiotics Office Poster (PDF) 
(www.cdc.gov/antibiotic-use/media/pdfs/CDC-AU-Wait-Room-Poster-18by24-P.pdf) 
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IEHP Educational Materials 
IEHP Antibiotics May NOT Always Be the Answer Handout (PDF) 
(www.iehp.org/content/dam/iehp-org/en/documents/kids-and-teens/related-resources/2023/Antibiotics-
Brochure_ENG.pdf) 

March, 2025 • © 2025, V2.0  36 

https://www.iehp.org/content/dam/iehp-org/en/documents/kids-and-teens/related-resources/2023/Antibiotics-Brochure_ENG.pdf


   

        
 

IEHP AAB Education (link is to the IEHP homepage) 
(www.iehp.org/) 

March, 2025 • © 2025, V2.0  37 

https://www.iehp.org/

	Brief Supplement Overview
	Brief Stewardship Plan Template
	Stewardship Team
	Stewardship Goals
	Meetings and Communication
	Commitment
	Action
	Tracking and Reporting
	Education
	Other notes

	Internal Stewardship Commitment Statement Template
	Healthcare Effectiveness Data and Information Set (HEDIS) Metric: Avoiding Antibiotics for Acute Bronchitis/Bronchiolitis (AAB)
	Resource Collections and Toolkits
	Sampling of Available Resources and Educational Materials
	CDC Provider Commitment Office Poster (PDF)
	CDC Provider Commitment Office Poster-Spanish (PDF)
	AHRQ Provider Commitment Office Poster (English and Spanish)
	AHRQ Commitment Poster Directions (Copied from AHRQ)
	CDC Delayed Antibiotic Prescribing Prescription Pad (PDF)
	CDC Delayed Antibiotic Prescribing Prescription Pad-Spanish (PDF)
	CDC Symptom Relief for Viral Illnesses Prescription Pad (PDF)
	CDC Symptom Relief for Viral Illnesses Prescription Pad-Spanish (PDF)
	CDC Symptom Relief for Cold and Cough Prescription Pad (PDF)
	CDC Symptom Relief for Cold and Cough Prescription Pad-Spanish (PDF)
	CDC Watchful Waiting Prescription Pad (PDF)
	CDC Watchful Waiting Prescription Pad-Spanish (PDF)
	Antibiotics and Adverse Events Provider Education (PDF)
	CDC: Do Antibiotics Have Side Effects? (PDF)
	CDC: Taking Your Antibiotics (PDF)
	CDC: Taking Your Antibiotics-Spanish (PDF)
	CDC Viruses or Bacteria Patient Handout (PDF)
	CDC Viruses or Bacteria Patient Handout-Spanish (PDF)
	CDC Antibiotics Aren’t Always the Answer Trifold for Patients (PDF) Page 1
	CDC Antibiotics Aren’t Always the Answer Trifold for Patients (PDF) Page 2
	CDC Preventing and Treating Bronchitis Patient Handout (PDF) Page 1
	CDC Preventing and Treating Bronchitis Patient Handout (PDF) Page 2
	CDC Use the Right Tool Office Poster (PDF)
	CDC Do You Need Antibiotics Office Poster (PDF)

	IEHP Educational Materials
	IEHP Antibiotics May NOT Always Be the Answer Handout (PDF)
	IEHP AAB Education (link is to the IEHP homepage)

	IEHP toolkit supplement 09-16-25_Fillable.pdf
	Brief Supplement Overview
	Brief Stewardship Plan Template
	Stewardship Team
	Stewardship Goals
	Meetings and Communication
	Commitment
	Action
	Tracking and Reporting
	Education
	Other notes

	Internal Stewardship Commitment Statement Template
	Healthcare Effectiveness Data and Information Set (HEDIS) Metric: Avoiding Antibiotics for Acute Bronchitis/Bronchiolitis (AAB)
	Resource Collections and Toolkits
	Sampling of Available Resources and Educational Materials
	CDC Provider Commitment Office Poster (PDF)
	CDC Provider Commitment Office Poster-Spanish (PDF)
	AHRQ Provider Commitment Office Poster (English and Spanish)
	AHRQ Commitment Poster Directions (Copied from AHRQ)
	CDC Delayed Antibiotic Prescribing Prescription Pad (PDF)
	CDC Delayed Antibiotic Prescribing Prescription Pad-Spanish (PDF)
	CDC Symptom Relief for Viral Illnesses Prescription Pad (PDF)
	CDC Symptom Relief for Viral Illnesses Prescription Pad-Spanish (PDF)
	CDC Symptom Relief for Cold and Cough Prescription Pad (PDF)
	CDC Symptom Relief for Cold and Cough Prescription Pad-Spanish (PDF)
	CDC Watchful Waiting Prescription Pad (PDF)
	CDC Watchful Waiting Prescription Pad-Spanish (PDF)
	Antibiotics and Adverse Events Provider Education (PDF)
	CDC: Do Antibiotics Have Side Effects? (PDF)
	CDC: Taking Your Antibiotics (PDF)
	CDC: Taking Your Antibiotics-Spanish (PDF)
	CDC Viruses or Bacteria Patient Handout (PDF)
	CDC Viruses or Bacteria Patient Handout-Spanish (PDF)
	CDC Antibiotics Aren’t Always the Answer Trifold for Patients (PDF) Page 1
	CDC Antibiotics Aren’t Always the Answer Trifold for Patients (PDF) Page 2
	CDC Preventing and Treating Bronchitis Patient Handout (PDF) Page 1
	CDC Preventing and Treating Bronchitis Patient Handout (PDF) Page 2
	CDC Use the Right Tool Office Poster (PDF)
	CDC Do You Need Antibiotics Office Poster (PDF)

	IEHP Educational Materials
	IEHP Antibiotics May NOT Always Be the Answer Handout (PDF)
	IEHP Antibiotics: What You Should Know Handout (PDF)
	IEHP AAB Education (link is to the IEHP homepage)



	Stew_Champ: 
	Fac_Lead_Stew_Contact: 
	Other_Team: 
	Stew_Goals1: 
	Stew_Goals: 
	Meetings_Update_Frequency: 
	Meetings_Communication_Date: 
	Meeting_Update_Frequency_Communication: 
	Committment1: 
	Committment2: 
	Meetings_Freq_Loc: 
	Action1: 
	Action2: 
	Track_Report1: 
	Track_Report2: 
	Edu1: 
	Edu2: 
	Other_Notes: Include additional notes and plans. This is also a good place to track feedback for IEHP and CDPH.
	Facility: Facility
	Stew_Champion: Stewardship Champion
	Location: location


